Eolas Technologies Incorporated v. Adobe Systems Incorporated et al Doc. 376 Att. 2

Exhibit 1B

Dockets.Justia.com


http://dockets.justia.com/docket/texas/txedce/6:2009cv00446/118976/
http://docs.justia.com/cases/federal/district-courts/texas/txedce/6:2009cv00446/118976/376/2.html
http://dockets.justia.com/

Claim

Claim Language

Exemplary Evidence from Sun’s websites

1d

wherein said first
distributed
hypermedia
document includes
an embed text
format, located at a

first location in said

first distributed
hypermedia

document, that
specifies the

location of at least
a portion of an
object external to
the first distributed
hypermedia

document,

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
combination thereof), operate in a hypermedia network environment that includes client workstations
executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that said first distributed
hypermedia document includes an embed text format, located at a first location in said first distributed
hypermedia document, that specifies the location of at least a portion of an object external to the first
distributed hypermedia document. In addition, Sun provides the infrastructure (e.g. servers, Sun’s
websites, etc.), in addition to instructions to users, and causes them to use Sun’s websites in an

infringing manner in its default and expected use.
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<div class="vidembed vidembedsm">
<div class="vidbox">

<div class="vidboxw1">

<div class="vidboxw2">

<div class="vidboxw3">

<div class="vidboxw4">

<iframe marginheight="0" scrolling="no" marginwidth="0" frameborder="0"
width="323" height="229"
src="/jsp_utils/vid.jsp?bctid=50218823001&amp;size=323x229"></iframe>

</div>
</div>
</div>
</div>
</div>

</div>

Source: Lines 744-768, Page Source,

http://www.sun.com/featured-articles/2009-1128/feature/index.sp
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<html><head>

<meta http-equiv="content-type" content="text/html; charset=1S0-8859-1">

</head><body><embed name="flashObj" src="vid_data/1640183659"
bgcolor="#FFFFFF"
flashvars="playerID=1640183659&amp;@videoPlayer=50218823001&amp;servicesURL=http:/
/services.brightcove.com/services&amp;cdnURL=http://admin.brightcove.com&amp;domain=e
mbed&amp;autoStart=false&amp;" base="http://admin.brightcove.com"
seamlesstabbing="false" type="application/x-shockwave-flash" allowfullscreen="true"
swliveconnect="true"
pluginspage="http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Version=

ShockwaveFlash" wmode="transparent” width="323" height="229">

</body></html>

Source: Lines 1-36, vid.htm, saved HTML Source code of http://www.sun.com/featured-articles/2009-

1128/feature/index.isp
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3 Page Info - http:/iwww.sun.com/featured-articles/2009-112B/featurel/index. jsp

General Media Petmissions  Security

Address Twpe iz}
hikkp: f fvnny-cdn. sun,comyjfimages)zotfzot_ssd_Flash_box3.jpag Image A
hitkp: f fwasny-cdn, sun, comyinmg'a, gif Image
hitkp: ffv-cdn, sun.comyfimy'oo_whitebg. png Background

=i

http: ffservices, brightcove. com/services/viewer fFederated_F9/16401836597isMid=1
application)x-shockwave-flash

[ECH ORI LTOE CCTEn )
Dimensions: Opx = 0px

Source: Mozilla Firefox -> Tools -> Page Info -> Media, http://www.sun.com/featured-articles/2009-

1128/feature/index.jsp
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<div class="k3stretch">

<p class="k3obj">

<iframe src="

http://webcast-west.sun.com/interactive/08D01545/index.html" width="1050" height="700"

scrolling="no" frameborder="0" name="content"></iframe>

</p>

</div

Source: Lines 387-404, HTML Page Source,

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2

*Allegation not limited to the browser in use
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<embed src="index_data/sun-t5140-t5240-tour_v1-0.swf" quality="high"
pluginspage="http://www.macromedia.com/go/getflashplayer" play="true" loop="true"
scale="showall" wmode="window" devicefont="false" bgcolor="#ffffff" name="sun-t5140-
t5240-tour_v1-0" menu="true" allowfullscreen="false"” allowscriptaccess="sameDomain"
salign=""" type="application/x-shockwave-flash" width="880" align="middle" height="565">
<noscript> <object classid="clsid:d27cdb6e-ae6d-11cf-96b8-444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#version=
8,0,0,0"

width="880" height="565" id="sun-t5140-t5240-tour_v1-0" aligh="middle">

<param name="allowScriptAccess" value="sameDomain" /> <param

name="allowFullScreen" value="false" /> <param name="movie"
value="sun-t5140-t5240-tour_v1-0.swf" /><param name="quality"

value="high" /><param name="bgcolor" value="#ffffff" /> <embed
src="sun-t5140-t5240-tour_v1-0.swf" quality="high" bgcolor="#ffffff"

width="880" height="565" name="sun-t5140-t5240-tour_v1-0"

align="middle" allowScriptAccess="sameDomain" allowFullScreen="false"
type="application/x-shockwave-flash"

pluginspage="http://www.macromedia.com/go/getflashplayer" /> </object>

</noscript>

Source: Line 46-59, index.htm, saved HTML Source code of

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2
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) Page Info - hitp:/fwww.sun.comfservers/coolthreads/t5140/galleryfindex.x...

o
!

2

.

o E

General Media Permissions  Securiky

| Address Type (B2
!http:,I',l'www-n:dn.sun.n:u:um,l'im,l'a.gif Image ~
hikkps f femany-cdn, sun, camyim/media-shell-gradient. jpg Background
ihttp:,l',l'www-n:dn.sun.n:u:um,l'im,l'lu:ugu:u_sun_shell.giF Background

! ALY SLIT i 05 in, Oj

hktp: ,l',l'wel:ucast-west.sun.n:-:um,l'interan:ti\.fe,l'EIEiDDl545?sun-t514D-t524tl-tu:uur_v1-El.st

_"E{I

Location:

Twpe: application)x-shockwave-flash
Size: 539.04 KB {551,975 bykes)
Dirensions: Opx = Op

Source: Mozilla Firefox -> Tools -> Page Info -> Media,

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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<OBJECT classid="clsid:D27CDB6E-AE6D-11cf-96B8-444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#versi
on=5,0,0,0"

WIDTH=770 HEIGHT=550 id=baseMovie>

<PARAM NAME=movie VALUE="baseMovie.swf"> <PARAM NAME=loop VALUE=false>
<PARAM NAME=menu VALUE=false> <PARAM NAME=quality VALUE=high> <PARAM
NAME=bgcolor VALUE=#FFFFFF> <EMBED src="baseMovie.swf" loop=false menu=false
quality=high bgcolor=#FFFFFF WIDTH=770 HEIGHT=550 TYPE="application/x-shockwave-
flash"
PLUGINSPAGE="http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Vers
ion=ShockwaveFlash" NAME=baseMovie></EMBED>

</OBJECT>

Source: Line 58-62, Page Source, http://webcast-west.sun.com/interactive/09B01894 51/

Page 74 of 266

*Allegation not limited to the browser in use




Claim

Claim Language

Exemplary Evidence from Sun’s websites

©) Page Info - http:/Awebcast-west.sun.com/interactive/09801894. .. E”E”E|

ok i &

General  Media Permissions  Security

‘http: fiwebcast-west, sun . com/finteractive/09601894_51/baseMovie swf  Embed

Location: htkpif fwebcast-west, sun, comfinter active /09801594 _51/baseMovie. swf
Type: applicationx-shockwave-Flash
Size: 14,39 kE (14,737 bvtes
Dimensions: Opx = Opx
Source: Mozilla Firefox -> Tools -> Page Info -> Media,

west.sun.com/interactive/09B01894 51/

http://webcast-

*Allegation not limited to the browser in use
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©J Page Info - http:Hfidentityhero.sun.com/

General  Media Permissions  Securiky

(=13

I:I:|:|: idenkitvhero, sun, comfimgrgamegradog. jpg
|
'http: ffidentityhero, sun. com/ima)plrfocterbtn. jpg Image

Location: htkp: ffidentitvbero,sun. comfgames | sunidrmgarmecontent, swf
: application):-shockwave-flash

Size: 1,389.09 KB (1,422,425 bytes)

Dimensions: Opx = 0px

Source: http://identityhero.sun.com/

*Allegation not limited to the browser in use
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©) Page Info - hitp:#/sunsolve.sun.com/richmedia/0308-VT19_Doc_2342... [2 |[B)(X]
" v N
\_é E‘" Te =
aeneral  Media Permissions  Security
i Addrass Type |
ihttp:,l',l'www.sun.cu:um,l'im,l'az_cnrner_l:ur.gif Background A_!
{http:
............ I
i thp:))desvsuncom, 112,207 . netjb)ssideysuncomn) 1), 9p2 )s280658861 7004472 A . |
ilhttp:,l',l'suns-:ulve.sun.cu:um,l'riu:hmeu:Iia,l'sunspectrum_FiIes,l'sSB12?266655'9[![!.giF Image w |
Location: htkp: fisunsolve. sun, com)richmediaf0308-wT19_DOC_234281/93_s10_wké,swf
Type: applicationyx=-shockwave-flash
Size: 3,601,77 KB (3,685,217 bytes)
Dirnensions: Opx = Opx
Source: http://sunsolve.sun.com/richmedia/0308-VT19 DOC_ 234281/
le wherein said object | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

has type
information

associated with it
utilized by said
browser to identify
and locate an
executable

application external

combination thereof), operate in a hypermedia network environment that includes client workstations
executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that said object has type
information associated with it utilized by said browser to identify and locate an executable application
external to the first distributed hypermedia document. In addition, Sun provides the infrastructure (e.g.
servers, Sun’s websites, etc.), in addition to instructions to users, and causes them to use Sun’s

websites in an infringing manner in its default and expected use.
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to the first

distributed <div class="vidembed vidembedsm"=>
hypermedia <div class="vidbox">

document,

<div class="vidboxw1">
<div class="vidboxw?2">
<div class="vidboxw3">

<div class="vidboxw4">

<iframe marginheight="0" scrolling="no" marginwidth="0" frameborder="0"
width="323" height="229"
src="/jsp_utils/vid.jsp?bctid=50218823001&amp;size=323x229"></iframe>

</div>
</div>
</div>
</div>
</div>

</div>

Source: Lines 744-768, Page Source, http://www.sun.com/featured-articles/2009-

1128/feature/index.isp
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Exemplary Evidence from Sun’s websites

<html><head>

<meta http-equiv="content-type" content="text/html; charset=1S0-8859-1">

</head><body><embed name="flashObj" src="vid_data/1640183659"
bgcolor="#FFFFFF"
flashvars="playerID=1640183659&amp;@videoPlayer=50218823001&amp;servicesURL=http:/
/services.brightcove.com/services&amp;cdnURL=http://admin.brightcove.com&amp;domain=e
mbed&amp;autoStart=false&amp;" base="http://admin.brightcove.com"
seamlesstabbing="false" type="application/x-shockwave-flash" allowfullscreen="true"
swliveconnect="true"
pluginspage="http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Version=

ShockwaveFlash" wmode="transparent” width="323" height="229">

</body></html>

Source: Lines 1-36, vid.htm, saved HTML Source code of http://www.sun.com/featured-articles/2009-

1128/feature/index.isp
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©J Page Info - http:ffwww.sun.com/featured-articles/2009-112B{feature. .. |;||E||z|

General | Media Permissions  Security

| Address Type s
ihttp:,l',l'www-cdn.sun.cl:nm,l'imagesp'zat,l'zat_ssd_FIash_baxS.jpg Image -
:http:,l',l'www—cdn.sun.cu:um,l'im,l'a.gif Image

| Rkt fvman-cdn, sun, corn fir oo _whitebg, prig Background

Dimensions: Opex = 0px

[] Blodk Images Fram services, brightcove. com
Media Preview:

Source: Mozilla Firefox -> Tools -> Page Info -> Media, http://www.sun.com/featured-articles/2009-

1128/feature/index.jsp
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) Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox
File Edit ‘Wiew History Bookmarks Tools Help

Exemplary Evidence from Sun’s websites

O -c

i [ M 'http:,l’,l’www.sun.com,l’Featured-articles,l’ZDD9-1128,|'Feature,|’index.jsp ]

mmodeling, hioinformatics, biophotonics, fluid dynamics, data
mining and intelligent systems.

CLUMEQ Challenges
+ |ncrease computing power and performance at the
Quebec City datacenter
+ Improve datacenter efficiency
+ Implement flexible technology
+ Expand research opportunities

CLUME®Q's Results
« 10xincrease in computing resources
+ Ahility to run substantially more complex simulations
and to return results more quickly
+ Substantial room to add additional capacity for future
expansion

The Sun Solution

‘ﬂf CLUME®, working closely with Sun
consultants, implemented a Sun
Constellation Systern, which combines
high-performance computing, networking,
 storage, and software into a fully integrated
* system. The system includes Sun Blade
60438 Modular Systerns with Sun Blade ¥6275 Server Modules, a
Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,
and Sun HPC software. Sun Services worked with the CLUMEQ
tear to provide project management, and to optimize the
_nlacement of cluster camponents to maximize the cooling

v | |G £
~
Now Playing » More
00:00 05:58
> B =mail é’ getlink. @ et vode b B
Watch and learn how Sun's HPC computing
solution helped worked for Universite
Laval
-
Technology History
In early 2009, Sun Microsystems, along with 1BM, HE, and twn
ather companies, respanded to the CLUMEG RFP. "we adke] o
hids far solutions thatwould specifically fitthe silo decpaagpack
remarks Parizeau. Ower the course of two years, an accounl icaim
from Sun hrecentad techniral decinns to L LIMED atthe Sin b

Transferring data From rov-srv4l.inplay. kubemogul.com...

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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<div class="k3stretch">

<p class="k3obj">

<iframe src="

http://webcast-west.sun.com/interactive/08D01545/index.html" width="1050" height="700"

scrolling="no" frameborder="0" name="content"></iframe>

</p>

</div

Source: Lines 387-404, HTML Page Source,

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2

*Allegation not limited to the browser in use
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<embed src="index_data/sun-t5140-t5240-tour_v1-0.swf" quality="high"
pluginspage="http://www.macromedia.com/go/getflashplayer" play="true" loop="true"
scale="showall" wmode="window" devicefont="false" bgcolor="#ffffff" name="sun-t5140-
t5240-tour_v1-0" menu="true" allowfullscreen="false"” allowscriptaccess="sameDomain"
salign=""" type="application/x-shockwave-flash" width="880" align="middle" height="565">
<noscript> <object classid="clsid:d27cdb6e-ae6d-11cf-96b8-444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#version=
8,0,0,0"

width="880" height="565" id="sun-t5140-t5240-tour_v1-0" aligh="middle">

<param name="allowScriptAccess" value="sameDomain" /> <param

name="allowFullScreen" value="false" /> <param name="movie"
value="sun-t5140-t5240-tour_v1-0.swf" /><param name="quality"

value="high" /><param name="bgcolor" value="#ffffff" /> <embed
src="sun-t5140-t5240-tour_v1-0.swf" quality="high" bgcolor="#ffffff"

width="880" height="565" name="sun-t5140-t5240-tour_v1-0"

align="middle" allowScriptAccess="sameDomain" allowFullScreen="false"
type="application/x-shockwave-flash"
pluginspage="http://www.macromedia.com/go/getflashplayer" /> </object>

</noscript>

Source: Line 46-59, index.htm, saved HTML Source code of

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2
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) Page Info - hitp:/fwww.sun.comfservers/coolthreads/t5140/galleryfindex.x...

»E 13 a

General Media Permissions  Securiky

| Address Tvpe
!http:,I',l'www-n:dn.sun.n:u:um,l'im,l'a.gif Image
hikkps f femany-cdn, sun, camyim/media-shell-gradient. jpg Background
ihttp:,l',l'www-n:dn.sun.n:u:um,l'im,l'lu:ugu:u_sun_shell.giF Background

| > &

Location: http:,l',l'wel:ucast-west.sun.n:-:um,l'interan:ti\.fe,l'EIEiDDlmzm-tnur_vl-El.st
Twpe: application)x-shockwave-flash

Size: 539,04 KB (551,975 bytes)

Dirensions: Opx = Op

Source: Mozilla Firefox -> Tools -> Page Info -> Media,

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2

*Allegation not limited to the browser in use

Page 84 of 266




Claim Claim Language Exemplary Evidence from Sun’s websites

°) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox

File Edit Wiew History  Bookmarks Tools  Help

r c }{, u{ | & http: v, sun.com/fserversicoolthreadstS 140/ gallery findex . xml?p=1&s=2 I "I..{LI' '| |?" GUULJ')D!
-

Elclose =

Experience It

Sun SPARC Enterprise T5140
Sun SPARC Enterprise T5240

%

]
Transferting data from webcast-west,sun.com...

Source: http://www.sun.com/servers/coolthreads/t5140/gallery/index.xml?p=1&s=2
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<OBJECT classid="clsid:D27CDB6E-AE6D-11cf-96B8-444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#versi
on=5,0,0,0"

WIDTH=770 HEIGHT=550 id=baseMovie>

<PARAM NAME=movie VALUE="baseMovie.swf"> <PARAM NAME=loop VALUE=false>
<PARAM NAME=menu VALUE=false> <PARAM NAME=quality VALUE=high> <PARAM
NAME=bgcolor VALUE=#FFFFFF> <EMBED src="baseMovie.swf" loop=false menu=false
quality=high bgcolor=#FFFFFF WIDTH=770 HEIGHT=550 TYPE="application/x-shockwave-
flash"
PLUGINSPAGE="http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Vers
ion=ShockwaveFlash" NAME=baseMovie></EMBED>

</OBJECT>

Source: Line 58-62, Page Source, http://webcast-west.sun.com/interactive/09B01894 51/
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©) Page Info - http:/Awebcast-west.sun.com/interactive/09801894. .. E”E”E|

ok i &

General  Media Permissions  Security

‘http: fiwebcast-west, sun . com/finteractive/09601894_51/baseMovie swf  Embed

Location: htkpif fwebcast-west, sun, comfinter active /09801594 _51/baseMovie. swf
Type: applicationx-shockwave-Flash
Size: 14,39 kE (14,737 bvtes
Dimensions: Opx = Opx
Source: Mozilla Firefox -> Tools -> Page Info -> Media,

west.sun.com/interactive/09B01894 51/

http://webcast-
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") SunMetTalk - Mozilla Firefox
File Edit  Wiew

Hiskory

Exemplary Evidence from Sun’s websites

Bookmarks  Tools  Help

* c x mﬁ'¢ httpe ffwebcast-west, sun. cominteractive/09E01534_51f I

v -| |28 cou |

Sun Upgrade Advantage Program

Improved Datacenter Lifecycle

Trade-in Calculator =

Call Me Now
Chat Now

[SeeacR

Craig Churchill
Global Director of Installed
Base Marketing,

Sun Microsystems, Inc.

__stoments I

. Introduction

. Why Should We Upgrade?

- What Are the Challenges?

. How Can Sun Help?

- Sun Upgrade Advantage
Program

- Common Upgrade Scenarios

. Trade-In Calculator

- Do the Math - Step 1

. Do the Math - Step 2

10. Get Going!

. Conclusion

SUN NET TALK Take 10
Sun Upgrade Advantage Program

oW N

oo s oo,

s

View more Sun Net Talk programs:

Done

|

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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) Page Info - http://java.sun.com/javaone/2009/general_sessions. jsp

! = r
o 4 &
General  Media Permissions  Security
Address Type iz}
htkp:ffiava, sun.comjavaone 2009 images/chayman. jpg Image ~
htkp:ffjava. sun. com)javacne) 2009 images) jgosling. jpg Image
htkp: ffiava, sun.comjavaonefimages/dot_DFDFDE, qif Image

< |

Locakion: htkp: ) ic.brightcove . comfservicesviewerfederated FArBawidth=3232height=3452fashID=rm

l Tvpe: appIin:atiDn,l'x-shu:uckwa'-.fe-l:lash]
Iz TRE (0 Oyies)
Dirnensions: Opx = Opx

Source: http://java.sun.com/javaone/2009/general _sessions.jsp
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) Page Info - hitp:/fwww.opensparc. net/publications/videos/opensparc-t1-on... =
=N 7 A
Lé E uB fa] £
General  Media Feeds  Permissions  Security
| address Tvpe B
| ':-.-:'-.-:'._ TEACAAN A FAFAMiaFan s e S amantamAatS s i FAA . oo 3 )
! LI P [ e ELA L CILAEL Eont ot AP QL C WG L LY LY I gl
|
1 —
|
| Mrk ] i il 3, : Lopd e [y = b L LA W
Location:
@fpm
[F{=H
Dirnensions: Opx = Opx
Source: http://www.opensparc.net/publications/videos/
if and wherein said | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

embed text format
is parsed by said
browser to

automatically

invoke said
executable
application to

combination thereof), operate in a hypermedia network environment that includes client workstations
executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that when said embed
text format is parsed by said browser it automatically invokes said executable application to execute on
said client workstation in order to display said object. In addition, Sun provides the infrastructure (e.g.
servers, Sun’s websites, etc.), in addition to instructions to users, and causes them to use Sun’s

websites in an infringing manner in its default and expected use.
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execute on said

client  workstation

] . <div class="vidembed vidembedsm">
in order to display

] . <div class="vidbox">
said object
<div class="vidboxw1">
<div class="vidboxw?2">
<div class="vidboxw3">

<div class="vidboxw4">

<iframe marginheight="0" scrolling="no" marginwidth="0" frameborder="0"
width="323" height="229"
src="/jsp_utils/vid.jsp?bctid=50218823001&amp;size=323x229"></iframe>

</div>
</div>
</div>
</div>
</div>

</div>

Source: Lines 744-768, Page Source, http://www.sun.com/featured-articles/2009-

1128/feature/index.isp

Page 91 of 266

*Allegation not limited to the browser in use




Claim

Claim Language
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<html><head>

<meta http-equiv="content-type" content="text/html; charset=1S0-8859-1">

</head><body><embed name="flashObj" src="vid_data/1640183659"
bgcolor="#FFFFFF"
flashvars="playerID=1640183659&amp;@videoPlayer=50218823001&amp;servicesURL=http:/
/services.brightcove.com/services&amp;cdnURL=http://admin.brightcove.com&amp;domain=e
mbed&amp;autoStart=false&amp;" base="http://admin.brightcove.com"
seamlesstabbing="false" type="application/x-shockwave-flash" allowfullscreen="true"
swliveconnect="true"
pluginspage="http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Version=

ShockwaveFlash" wmode="transparent" width="323" height="229">

</body></html|>

Source: Lines 1-36, vid.htm, saved HTML Source code of http://www.sun.com/featured-articles/2009-

1128/feature/index.jsp
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*J Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox

File Edit Wiew Hiskory Bookmarks Tools  Help

& -c

g [& 'http:,l',l'www.sun.com,l'Featured—articles,l'ZDDQ—1128,|'Feature,|'index.jsp i | . #| Gongle

madeling, bicinfarmatics, biophotonics, fluid dynamics, data
mining and intelligent systems.

CLUMEQ Challenges
+ Increase computing power and performance at the
Cuehes City datacentar
+ Improve datacenter efficiency
+ Implement flexible technology
+ Expand research opporunities

CLUMEQ's Results

10x increase in computing resources

Ablllt‘y’tﬂ run substantially more complex simulations

and to return results more guickly

» Substantial room to add additional capacity for future
expansion

The Sun Solution

‘ﬁf CLUMEQ, working closely with Sun
wnsultants implemented a Sun
Cnnstellatlnn System, which cambines
high-performance computing, networking,
| storage, and software into a fully integrated
© gystemn. The system includes Sun Blade
6048 Modular Systemns with Sun Blade ¥6275 Server Modules, a

and Sun HPZ software. Sun Services worked with the CLUMER
team to provide project management, and to optimize the
nlacement of cluster components o maximize the cooling

Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,

Now Playing # Mare

Q000 05:53

> B2 email C? getlink: 8% get code S ]

Watch and learn how Sun's HPC computing
solution helped worked for Universite
Lawval

b

Technology History

In early 2008, Sun Microsystems, along with IBM, HE, and two
other companies, responded to the CLUMEQ RFP. "we adl=] 1ol
hids far solutions thatwould specifically fitthe silo desiBaagnack

remarks Farizeau. Overthe course of two years, an accouinl leain
from Sun nresented terhnical desinns to 5L LIMED at the Sin

Transferring data from roy-srvd 1. inplay, bubemogul,. com. ..

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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<div class="k3stretch">

<p class="k3obj">

<iframe src="

http://webcast-west.sun.com/interactive/08D01545/index.html" width="1050" height="700"

scrolling="no" frameborder="0" name="content"></iframe>

</p>

</div

Source: Lines 387-404, HTML Page Source,

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2
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<embed src="index_data/sun-t5140-t5240-tour_v1-0.swf" quality="high"
pluginspage="http://www.macromedia.com/go/getflashplayer" play="true" loop="true"
scale="showall" wmode="window" devicefont="false" bgcolor="#ffffff" name="sun-t5140-
t5240-tour_v1-0" menu="true" allowfullscreen="false"” allowscriptaccess="sameDomain"
salign=""" type="application/x-shockwave-flash" width="880" align="middle" height="565">
<noscript> <object classid="clsid:d27cdb6e-ae6d-11cf-96b8-444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#version=
8,0,0,0"

width="880" height="565" id="sun-t5140-t5240-tour_v1-0" aligh="middle">

<param name="allowScriptAccess" value="sameDomain" /> <param

name="allowFullScreen" value="false" /> <param name="movie"
value="sun-t5140-t5240-tour_v1-0.swf" /><param name="quality"

value="high" /><param name="bgcolor" value="#ffffff" /> <embed
src="sun-t5140-t5240-tour_v1-0.swf" quality="high" bgcolor="#ffffff"

width="880" height="565" name="sun-t5140-t5240-tour_v1-0"

align="middle" allowScriptAccess="sameDomain" allowFullScreen="false"
type="application/x-shockwave-flash"
pluginspage="http://www.macromedia.com/go/getflashplayer" /> </object>

</noscript>

Source: Line 46-59, index.htm, saved HTML Source code of

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2
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Wiew

Exemplary Evidence from Sun’s websites
2) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox
Elle  Edit

Hiskory

Bookmarks  Tools

Help

- C X

| & htkp: S, sun.comfserversfcoolthreads 5140/ gallery findex, xml?p=1&s=2
Experience It

Stills | 3600

¥y -

m' Googl ).-‘!

-~

ElClose

Sun SPARC Enterprise T5140
Sun SPARC Enterprise T5240

4 I
Transferring data from webcast-west.sun.com. ..

Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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<OBJECT classid="clsid:D27CDB6E-AE6D-11cf-96B8-444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#versi
on=5,0,0,0"

WIDTH=770 HEIGHT=550 id=baseMovie>

<PARAM NAME=movie VALUE="baseMovie.swf"> <PARAM NAME=loop VALUE=false>
<PARAM NAME=menu VALUE=false> <PARAM NAME=quality VALUE=high> <PARAM
NAME=bgcolor VALUE=#FFFFFF> <EMBED src="baseMovie.swf" loop=false menu=false
quality=high bgcolor=#FFFFFF WIDTH=770 HEIGHT=550 TYPE="application/x-shockwave-
flash"
PLUGINSPAGE="http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Vers
ion=ShockwaveFlash" NAME=baseMovie></EMBED>

</OBJECT>

Source: Line 58-62, Page Source, http://webcast-west.sun.com/interactive/09B01894 51/
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’) SunMetTalk - Mozilla Firefox

File  Edit

Wigw  History  Bookmarks  Tools  Help

Exemplary Evidence from Sun’s websites

vy -]

> b c x mﬁ@ http:/fwebcast-west, sun.comfinteractive/09B01594_51] I

SUN NET TALK Take 10
Sun Upgrade Advantage Program

1

2

3

Sun Upgrade Advantage Program 4
| Datacenter Lifecycle ’

6

7

a8

9

10

. Common Upgrade Scenarios
. Trade-in Calculator

. Do the Math - Step 1

. Do the Math - Step 2

- Get Going!
. Conclusion

Trade-in Calculator

Call Me Now

Chat Now

[seace

Craig Churchill

Global Director of Installed
Base Marketing,

Sun Microsystems, Inc.

__stoments I

. Introduction

. Why Should We Upgrade?
- What Are the Challenges?
. How Can Sun Help?

- Sun Upgrade Advantage

Program

View more Sun Net Talk programs:

E B

)

Dorne

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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) Compete to win $50 in Identity Hero merchandise by heing this month's winning team! - Mozilla Firefox

File Edit ‘Wiew History Bookmarks  Wired-Marker  Tools  Help

O -c

imt (._I http:ffidentityhero,sun.comf ]

$15270795

Your group:

TOTAL COST SAVINGS:

Rescue today’s identity-imperiled enterprise.

ID MANAGEMENT POWER

Use Arrow Keys to Move

Press Spacebar to Pause

Dane

Source: http://identityhero.sun.com/
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) 2009 JavaOne Conference - General Session Details and ¥ideo Replays - Mozilla Firefox

File Edit Miew History Bookmarks Tools  Help
B

@ - c x o=

General Session Details and Video Replays

ava, sun.com/javaons 2009/ general _sessions.jsp

[Seamh.. n f.-]

Yideo Support

» MISSED A GENERAL SESSIONT: Watch the replay(s) —
added shortly after broadcast

» Sun General Session: Java: Change {Yyour World @ |
more details

# Sun Technical General Session: intelligent Design: The
Pervasive Java Platforim @ | more details

* Sony Ericsson General Session: Being Unique with Sony
Ericsson @ | more details

Chapt

# Sun General Session: Your Java Lifestyle: Mobile, TV and

a0 J 3403
Beyonid @& | more details
B PLAY amail ¢ getlink @ ogeteode el W)
ChaptEl’ 1 Javalne 2009 Opening General Ses ¥ Microsoft General Session: Software + Services: The Next

The Power of a Simple Ides, Chris Melissinos welcome, Jonath.., Application Platform @ | more details

*IBM General Session: Extreme Transaction Processing

5 and Elasticity — the Answer for Your Most Demanding
Applications & | more detailz

¥ Sun General Session: James Gosling's Toy Show @& |
mare details

Back to JawaOne Home Page View the Schedule

Connecting to receive.inplay, tubemogul. com ...

Source: http://java.sun.com/javaone/2009/general_sessions.jsp
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) Introduction to NetBeans IDE 6.8 - Mozilla Firefox
Filz  Edit Bookmarks

Wiew  History Tools  Help

h G http: /{netbeans. orgfkbdocs/ide foverview-screencasthtml

Features

Plugins

HOME / Drocs & Support

lNetBeans IDE 6.8 Overview

The MetBeans

IDE is an

integrated

developrnent

enviranmment for

software = Java Pr

developers, It = :

contains the Devely

tonls you need Java EE

to create

professional

deslktop, ]

enterprise, web, .I‘ b2l

and robile 3 .

applications with Plﬂy Video 4

the Java = Cet Sur

language, as Assistal

well as CACT++, 5

FHF, JavaScript, = Get Sur

Groovy, and Mow

Ruby,

See what is new Hgon 0623 =

ia'-t'd iol'\?ltlg the B LAY M ezl P getink @ et code o M) | MENU Docurm

atest MetBeans 5

MF & & the | = Genera bl
| b
|

Source: http://netbeans.org/kb/docs/ide/overview-screencast.html

1g

and enable an end-

user to directly

Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the

combination thereof), operate in a hypermedia network environment that includes client workstations

*Allegation not limited to the browser in use
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interact with said
object within a
display area
created at said first
location within the
portion of said first
distributed

hypermedia

document being
displayed in said
first browser-

controlled window.

executing browsers. Sun’s servers transmit a series of communications to client workstations in the
distributed hypermedia network. Sun’s servers format the communications so that an end-user is
enabled to directly interact with said object within a display area created at said first location within the
portion of said first distributed hypermedia document being displayed in said first browser-controlled
window. In addition, Sun provides the infrastructure (e.g. servers, Sun’s websites, etc.), in addition to
instructions to users, and causes them to use Sun’s websites in an infringing manner in its default and

expected use.
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<div class="vidembed vidembedsm">
<div class="vidbox">

<div class="vidboxw1">

<div class="vidboxw2">

<div class="vidboxw3">

<div class="vidboxw4">

<iframe marginheight="0" scrolling="no" marginwidth="0" frameborder="0"
width="323" height="229"
src="/jsp_utils/vid.jsp?bctid=50218823001&amp;size=323x229"></iframe>

</div>
</div>
</div>
</div>

</div>

</div>

Source: Lines 744-768, Page Source, http://www.sun.com/featured-articles/2009-

1128/feature/index.isp
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<html><head>

<meta http-equiv="content-type" content="text/html; charset=1S0-8859-1">

</head><body><embed name="flashObj" src="vid_data/1640183659"
bgcolor="#FFFFFF"
flashvars="playerID=1640183659&amp;@videoPlayer=50218823001&amp;servicesURL=http:/
/services.brightcove.com/services&amp;cdnURL=http://admin.brightcove.com&amp;domain=e
mbed&amp;autoStart=false&amp;" base="http://admin.brightcove.com”
seamlesstabbing="false" type="application/x-shockwave-flash" allowfullscreen="true"
swliveconnect="true"
pluginspage="http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Version=

ShockwaveFlash" wmode="transparent” width="323" height="229">

</body=></html|>

Source: Lines 1-36, vid.htm, saved HTML Source code of http://www.sun.com/featured-articles/2009-

1128/feature/index.isp
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*J Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox

File Edit Wiew Hiskory Bookmarks Tools  Help

& -c

P

g [& -http:,l',l'www.sun.com,l'Featured—articles,l'ZDDQ—1128,|'Feature,|'index.jsp T | . #| Gongle

madeling, bicinfarmatics, biophotonics, fluid dynamics, data
mining and intelligent systems.

CLUMEQ Challenges
+ Increase computing power and performance at the
Cuehes City datacentar
+ Improve datacenter efficiency
+ Implement flexible technology
+ Expand research opporunities

CLUMEQ's Results

10x increase in computing resources

Ablllt‘y’tﬂ run substantially more complex simulations

and to return results more guickly

» Substantial room to add additional capacity for future
expansion

The Sun Solution

‘g:’ CLUMEQ, working closely with Sun

- wnsultants implemented a Sun
Cnnstellatlnn System, which cambines
high-performance computing, networking,

. storage, and software into a fully integrated

© gystemn. The system includes Sun Blade

6048 Modular Systemns with Sun Blade ¥6275 Server Modules, a

and Sun HPZ software. Sun Services worked with the CLUMER
team to provide project management, and to optimize the
nlacement of cluster components o maximize the cooling

Now Playing # Mare

Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,

Q000 05:53

)

| B =mail (_? get link a get code

Watch and learn how Sun's HPC computing
solution helped worked for Universite
Lawval

Technology History

In early 2008, Sun Microsystems, along with IBM, HE, and two
other companies, responded to the CLUMEQ RFP. "we adl=] 1ol
hids far solutions thatwould specifically fitthe silo desiBaagnack

remarks Farizeau. Overthe course of two years, an accouinl leain
from Sun nresented terhnical desinns to 5L LIMED at the Sin

Transferring data from roy-srved 1. inplay, bubemogul. com.

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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©J Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox

File Edit View History Bookmarks Tools  Help

cosmology, nanamaterials, supramolecular
maodeling, bioinformatics, hiophotonics, fluid dynamics, data
mining and intelligent systems.

CLUMEQ Challenges
« Increase computing power and performance at the
Guebec City datacenter
« Improve datacenter efficiency
« Implement flexible technology
« Expand research opportunities

CLUMEQ's Results

« 10xincrease in camputing resources

« Ability to run substantially more complex simulations
and to return results moare guickly

+ Substantial room to add additional capacity for future
expansion

The Sun Solution

‘ﬁ? CLUME®R, waorking closely with Sun

: N consultants, implemented a Sun
Constellation System, which combines
high-performance computing, netwarking,
storage, and software into a fully integrated
systemn. The system includes Sun Blade
G048 Modular Systerms with Sun Blade ¥B275 Server Modules, a
Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,
and Sun HRPC software. Sun Services warked with the CLUMEQ
team to provide project management, and to aptimize the

il | @ .http:II',l'www.sun.com,l'Featured-articles}'ZDDg-1128}'Feature,l'index.jsp ‘,i,’ - '

» hore

a

Now Playing

01:51 i) n&se
@ 'ﬂ emaill é’ get link 5 get codel

Watch and learn how Sun's HPC computing
solution helped worked for Universite
Laval

Technology History

In early 2009, Sun Microsystems, along with 1B, HP, and [mp:]
other caompanies, responded to the CLUMER RFF. ™A :'Féed'ﬁéék
hids for solutions that would specifically fit the silo desigh,
remarks Parizeau, Over the course of two vears, an account team

Transferring data from sun.edgeboss.net. .

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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<div class="k3stretch">

<p class="k3obj">

<iframe src="

http://webcast-west.sun.com/interactive/08D01545/index.html" width="1050" height="700"

scrolling="no" frameborder="0" name="content"></iframe>

</p>

</div

Source: Lines 387-404, HTML Page Source,

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2
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<embed src="index_data/sun-t5140-t5240-tour_v1-0.swf" quality="high"
pluginspage="http://www.macromedia.com/go/getflashplayer" play="true" loop="true"
scale="showall" wmode="window" devicefont="false" bgcolor="#ffffff" name="sun-t5140-
t5240-tour_v1-0" menu="true" allowfullscreen="false"” allowscriptaccess="sameDomain"
salign=""" type="application/x-shockwave-flash" width="880" align="middle" height="565">
<noscript> <object classid="clsid:d27cdb6e-ae6d-11cf-96b8-444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#version=
8,0,0,0"

width="880" height="565" id="sun-t5140-t5240-tour_v1-0" aligh="middle">

<param name="allowScriptAccess" value="sameDomain" /> <param

name="allowFullScreen" value="false" /> <param name="movie"
value="sun-t5140-t5240-tour_v1-0.swf" /><param name="quality"

value="high" /><param name="bgcolor" value="#ffffff" /> <embed
src="sun-t5140-t5240-tour_v1-0.swf" quality="high" bgcolor="#ffffff"

width="880" height="565" name="sun-t5140-t5240-tour_v1-0"

align="middle" allowScriptAccess="sameDomain" allowFullScreen="false"
type="application/x-shockwave-flash"

pluginspage="http://www.macromedia.com/go/getflashplayer" /> </object>

</noscript>

Source: Line 46-59, index.htm, saved HTML Source code of

http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xm|?p=1&s=2
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Wiew

Bookmarks  Tools

Exemplary Evidence from Sun’s websites
2) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox
Elle  Edit

Hiskory

Transferring data from webcast-west.sun.com. ..

Help

- C X

| & htkp: S, sun.comfserversfcoolthreads 5140/ gallery findex, xml?p=1&s=2
Experience It

Stills | 3600

¥y -

Sun SPARC Enterprise T5140
Sun SPARC Enterprise T5240

m' Googl ).-‘!

-~

ElClose

|i%

Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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File Edit “ew History Bookmarks Tools  Help

4 Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox

Exemplary Evidence from Sun’s websites

6 - c ;2’—‘ i l_@ http: S, sun,comfserversicoolthreads 15140/ gallery findex, xml?p=1&s=2

X

";?" -'3-:-:u_1|)':"l

Experience It

Sun SPARC Enterprise T5140
Sun SPARC Enterprise T5240

(.

Wiew

Front

Rear

Internals

| £

Transferting data From webcast-west, sun.com...

Source: http://www.sun.com/servers/coolthreads/t5140/gallery/index.xml?p=1&s=2
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<OBJECT classid="clsid:D27CDB6E-AE6D-11cf-96B8-444553540000"
codebase="http://download.macromedia.com/pub/shockwave/cabs/flash/swflash.cab#versi
on=5,0,0,0"

WIDTH=770 HEIGHT=550 id=baseMovie>

<PARAM NAME=movie VALUE="baseMovie.swf"> <PARAM NAME=loop VALUE=false>
<PARAM NAME=menu VALUE=false> <PARAM NAME=quality VALUE=high> <PARAM
NAME=bgcolor VALUE=#FFFFFF> <EMBED src="baseMovie.swf" loop=false menu=false
quality=high bgcolor=#FFFFFF WIDTH=770 HEIGHT=550 TYPE="application/x-shockwave-
flash"
PLUGINSPAGE="http://www.macromedia.com/shockwave/download/index.cgi?P1_Prod_Vers
ion=ShockwaveFlash" NAME=baseMovie></EMBED>

</OBJECT>

Source: Line 58-62, Page Source, http://webcast-west.sun.com/interactive/09B01894 51/
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’) SunNetTalk - Mozilla Firefox

File Edit ‘Wew History Bookmarks Tools  Help

B O X mﬁ@ hittp:/ fwebcast-west, sun.comfinteractive /09E01594_51 I

vy -| [~ cou P

-~

Trade-in Calculator
Call Me Now
Chat Now

[seace

Craig Churchill

Global Director of Installed
Base Marketing,

Sun Microsystemns, Inc.

__stoments I

- Introduction

. Why Should We Upgrade?

- What Are the Challenges?

. How Can Sun Help?

- Sun Upgrade Advantage
Program

. Common Upgrade Scenarios

« Trade-in Calculator

- Do the Math - Step 1

. Do the Math - Step 2

10. Get Going!

11. Conclusion

—

L R

0o o

Click toPlay | _

LIEIESED oor0s:34 | (KINSY L3 B3 £ kTl o

% |

Cone |lg=

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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*) SunNetTalk - Mozilla Firefox

File Edit View History Bookmarks Tools  Help

c x {24 I: 0 http:f fwebcast-west . sun. comfinkeractive/09B01894_51/ ﬁ '| |'.’,l' Goog‘p|

SUN NET TALK Take 10
Sun Upgrade Advantage Program

Craig Churchill

Global Director of Installed
Base Marketing,
Sun Microsystems, Inc.

SEGMENTS

« Introduction

- Why Should We Upgrade?

- What Are the Challenges?

- How Can Sun Help?

- Sun Upgrade Advantage
Program

- Common Upgrade Scenarios

- Trade-in Calculator

Do the Math - Step 1

. Do the Math - Step 2

10. Get Gaing!

. Conclusion

B W N

Sun Upgr de Advantage Program

tacenter Lifecycle

View more Sun Net Talk programs:

Diong |

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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%3 Compete to win $50 in Identity Hero merchandise by being this month’s winning team! - Mozilla Firefox
File Edit View

o -c

History — Bookmarks  Wired-Marker Tools  Help

o (._] http:fidentityhera, sun,com) ]
Compete to win $50 in Identity Hero merchandise by being this month’s winning team!

$15270795

Your group:

TOTAL COST SAVINGS:

Rescue today’s identity-imperiled enterprise.

ID MANAGEMENT POWER

Use Arrow Keys to Move

Press Spacebar to Pause

Done

Source: http://identityhero.sun.com/
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3 Compete to win 550 in Identity Hero merchandise by being this month's winning team! - Mozilla Firefox

File Edit ‘iew History EBookmarks Wired-Marker Tools  Help

N} ' ,_] |http: fidentitvhera,sun.com/
Compete to win $50 in Identity Hero merchandise by being this month's winning team!

Leader:
DIs

$15270795

Your group:

TOTAL COST SAVINGS:
LIVES:

TIME:
Rescue today’s identity-imperiled enterprise. -

ID MANAGEMENT POWER

Use Arrow Keys to Move Press Spacebar to Pause

Done

Source: http://identityhero.sun.com/
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File  Edit  Miew  History

?) DpenSPARE T1 on Xilinx FPGA Board | videos | publications - Mozilla Firefox
Bookmarks

Exemplary Evidence from Sun’s websites

Tools  Help

o c 20 g b s hktpefsees.opensparc.net fpublications videos/opensparc-t1-on-siline-Frga-board. bl

CMT Whitepaper

This white
paper
highlights
the

= technical
— henefits
Sun's chip multithreading
{CMT) UltraSPARC T2
processor delivers to
muttithr eaded applications,
and provides detailed
examples of significant
performance gains in three
application workloads: telco,
cryptography, and string
searching.

White Paper: Multithreaded
Application Acceleration with
Chip Multithreading (CMT)

OpenSPARC T1 on Xilinx FPGA Board

[E]written by Sun Microsystems

23 Thursday, 03 July 2008 03:00

Avideo demonstrating OpenSPARC T1 runing on the Xilin Vitex 4 FPGA board.

son/:34 o N 9

OpenSPARC T1.processor.on.Xilinx. FPGA technol..
Ty - -

iy Hits:724 Gzl Email this Bookmark

7

|

Set as favorite

Source: http://www.opensparc.net/publications/videos/
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File

) OpenSPARC T1 on Xilinx FPGA Board | videos | publications - Mozilla Firefox
Tools  Help

;@; {el | 95tk fww.opensparc. netfpublications| videos/openspare-t1-on-xdline-fpoa-board. html

Edit  Views History  Bookmarks
5 C
CMT Whitepaper
This white
paper
highlights
the
| technical
L

benefits

Sun's chip multithreading
{CMT) UltraSPARC T2
processor delivers to
multithreaded applications,
and provides detailed
examples of significant
performance gains in three
application workloads: telco,
cryptography, and string
searching.

White Paper: Multithreaded
Application Acceleration with
Chip Multithreading (ChMT)

OpenSPARC T1 on Xilinx FPGA Board

[ written by Sun Microsystems
23 Thursday, 03 July 2008 03:00

Aviden demonstrating OpenSPARC T1 runing on the Kilire Vitex 4 FPGA board.

OpenSPARC T1 processor.on Xilinx. FPGA technol..

A a=

il Hits: 724 0 Ernail this Bookmark

|

¢ Setas favorite

Source: http://www.opensparc.net/publications/videos/
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2pre The method of | Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
claim 1, wherein | combination thereof), operate in a hypermedia network environment that includes client workstations
said executable | executing browsers which further comprises the method of claim 1, said executable application is a
application is a | controllable application and further comprises the following steps. In addition, Sun provides the
controllable infrastructure (e.g. servers, Sun’s websites, etc.), in addition to instructions to users, and causes them
application and | to use Sun’s websites in an infringing manner in its default and expected use.

further comprising

the step of:
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File

Sun Microsystems Feature Story: CLUMEQ - Mozilla Firefox

Edit Yiew History Bookmarks Tools  Help

- c A Gy I:_&'http:,l’,l'www.sun.com,l’Featured-articIes,l’ZDDQ-1128,|’Feature,|’index.jsp T T

cosmology, nanomaterials, supramolecular
modeling, hioinformatics, hiophotonics, fluid dynamics, data
mining and intelligent systems.

CLUMEQ Challenges
+ Increase computing power and performance atthe
Guebes City datacenter
Improve datacenter efiiciency
Implement flexible technology
+ Expand research opportunities

CLUMEQ@'s Results

« 10xincrease in computing resources

+ Ahility to run substantially mare complex simulations
and to return results maore guickly

+ Substantial room to add additional capacity for future
expansion

The Sun Solution

B CLUMEQ, working closely with Sun

- consultants, implemented a Sun
Constellation System, which combines
high-performance computing, networking,
storage, and software into a fully integrated
system. The system includes Sun Blade
6048 Modular Systermns with Sun Blade ¥6275 Server Modules, a
Sun Lustre Storage System, Sun Datacenter InfiniBand Switches,
and Sun HPC software. Sun Services worked with the CLUMEQ
team to provide project management, and to optimize the

Now Playing » hore

01:51 0552
@ ‘ﬂ emaill é’ get link 6 get codel

Watch and learn how Sun's HPC computing
solution helped worked for Universite
Laval

Technology History

In early 2009, Sun Microsystemns, along with [BM, HP, and ch]
other companies, responded to the CLUMEQ REP."A :'Féed'b:éélk
bids for solutions that would specifically fit the silo desigh,

Transferring data from sun.edgeboss.net. ..

remarks Parizeau, Over the course of two vears, anaccount tearn.

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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&) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox
File Edit “iew History Bookmarks Tools  Help

6 - c A oY 'im hittp: f o, sun.comyservers/coolthreadst5 140/ gallery findex. xmlfp=18s=2 T:.? =

| - 3 =l
128~ coodl 2|

A
Experience It EClose &

View “ Benefits E l

Front:

Rear

Internals

Sun SPARC Enterprise T5140 7
Sun SPARC Enterprise T5240

3

%

Transferring data from webcast-west sun.com...

Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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*) SunNetTalk - Mozilla Firefox

File. Edit Wiew History Bookmarks  Tools  Help

.%J' c x @ I° http:f fwebcast-west. sun.comfinteractive /09801594 51/ ﬁ v| |'.!T" Googpl

SUN NET TALK Take 10 Trade-in Calculator
Call Me Now

Sun Upgrade Advantage Program

Craig Churchill
Global Director of Installed
Base Marketing,

Sun Microsystems, Inc.

Introduction

. Why Should We Upgrade?

. What Are the Challenges?

. How Can Sun Help?

- 5un Upgrade Advantage
Program

. Common Upgrade Scenarios

. Trade-in Calculator

- Do the Math - Step 1

« Do the Math - Step 2

10. Get Gaing!

. Conclusion

Sun Upgrade Advantage Program

Improv center cycle

noB WM

View more Sun Net Talk programs:

Dane |

Source: http://webcast-west.sun.com/interactive/09B01894 51/
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2) DpenSPARC T1 on Xilinx FPGA Board | videos | publications - Mozilla Firefox

Eile

Tools  Help

Edit  Miew History  Bookmarks
-+ C X
CMT Whitepaper
This white
paper
highlights
the
technical
- henefits
Sun's chip multithreading
(CMT) UtraSPARC T2

processor delivers to
mulktithreaded applications,
and provides detailed
examples of significant
performance gains in three
application workloads: telco,
cryptography, and string
searching.

White Paper: Multithreaded
Application Acceleration with
Chip Multithreading (CwT)

(g | Ps  htkpeffenens, openspare. netjpublicationsivideos{opensparc-t 1-on-silinx-fpga-board bl

OpenSPARC T1 on Xilinx FPGA Board

[] Wuiritten by Sun Microsystems
T3 Thursday, 03 July 2008 03:00

Avideo demonstrating Open3SFPARC T1 runing on the XilindVidex 4 FRGA hoard.

OpenSPARC T1 processor.on Xilinx.FPGA technol..
5 v l

XXy

s Sy W . L’ g

g

ooo/1:34 | o | =0 E9

2a=

s Hits: 724 E5] Email this Bookmark g

Set as favarite

Done

Source: http://www.opensparc.

net/publications/videos/opensparc-tl-on-xilinx-fpga-board.html
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&) The Solid State Storage Revolution : Storage Stop - Mozilla Firefox
File Edit Miew History Bookmarks  Tools  Help

@ - c 2l M http: ffblogs . sun.comyistoragefen_US entry/the_solid_stake_storage_rewolution 0 77 - "'l' .
u'{ﬂ}unes‘.:d_.,' UL L2, ZUTD Eriglish o
The Solid State Storage Revol fkeas

Espafinl

PYCCEMA

Parugués Brasil

Archives
« December 2009
Sun Mon Tue Wed Thu Fri Sat
i o4 &
i in 11 12
13 17 18 14
20 24 35 76
27 |

Aggregate RSS Feed
for Sun Storage
Blogs

RSS

£zn Storaoe Blog:

|| 00200 S B Feeds for Storage
Andy Bechtolsheim speaking at SNIA SDC, Sept 2008, Stop

3 a0
Click the square icon in the lower right corner of the player to view a full-screen version. J Mlews

Dane

Source: http://blogs.sun.com/storage/en_US/entry/the_solid_state storage_revolution
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2a interactively Users of Sun’s websites, the websites themselves and/or the servers hosting those websites (and/or the
controlling said | combination thereof), operate in a hypermedia network environment that includes client workstations
controllable executing browsers. Sun’s servers transmit a series of communications to client workstations in the

application on said | distributed hypermedia network. Sun’s servers format the communications so that there is interactive

client workstation | control of said controllable application on said client workstation via inter-process communications

via inter-process | between said browser and said controllable application. In addition, Sun provides the infrastructure (e.g.
communications servers, Sun’s websites, etc.), in addition to instructions to users, and causes them to use Sun’s
between said | websites in an infringing manner in its default and expected use.

browser and said
controllable

application.
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©) Sun Microsystems Feature Story: CLUMEQ. - Mozilla Firefox

Edit  Wiew

- C

History  Bookmarks  Tools  Help

cosmology, nanamaterials, supramolecular
modeling, hioinfarmatics, biophotonics, fluid dynamics, data
mining and intelligent systems.

CLUME®Q Challenges

« Increase computing power and performance at the
Quehec City datacenter

« Improve datacenter efficiency

« Implement flexible technalogy

« Expand research opportunities

CLUMEQ's Results

« 10xincrease in computing resources

+ Ability to run substantially mare camplex simulations
and to return results mare quickly

« Substantial room to add additional capacity for future
expansion

The Sun Solution

‘ﬂ:‘: CLUME®R, warking closely with Sun
3 consultants, implementad & Sun
Constellation System, which combines
high-perfarmance computing, netwarking,
storage, and software into a fully integrated

© gystem. The system includes Sun Blade
BE048 Modular Systems with Sun Blade ¥6275 Server Modules, a
Sun Lustre Storage Systemn, Sun Datacenter InfiniBand Switches,
and Sun HPC software. Sun Services worked with the CLUMEGQ

team to provide project management, and to optimize the

ot I & htkps iy, sun, comiFeatured-articles2003- 1128 Feature/findex. jsp i:? b

Neow Playing

05:52

'E emaillié’ getlinkiﬁ get code' @

o1:51

Watch and learn how Sun's HPC computing
solution helped worked for Universite
Laval

Technology History

In early 2009, Sun Microsystems, along with 1BM, HP, and Ee\tc]
other companies, responded to the CLUMEG RFP. "W 'Féed'b:éék
bids for solutions that would specifically fitthe silo desigh,

remarks Parizeau, Over the courge of two vears, an account tearm

Transferring data From sun.edgeboss.net ..

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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0024

05:58 o0:a3

e B email c,;’ get link: e get code

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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s

LS
u

i
e
LN
L
N,
LY
L

y 7 FIr

p2:52

0311 = 0552
il & email 09 getlink @) get code W

il B email é’get link: €2 et code e

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp
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] % email é’ get link € get code i F 1] B email cf’ get fink

Source: http://www.sun.com/featured-articles/2009-1128/feature/index.jsp

a get code o o3
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) Sun SPARC Enterprise T5140 Server Gallery - Mozilla Firefox

File Edit ‘iew History Bookmarks Tools  Help

6 ¥ c A 1ot '& http: ffvave, sun.comyservers/coolthreads/tS140fgalleryfindex. xml?p=1&s=2

Wiew

Front

Rear

Internals

Sun SPARC Enterprise T5140
Sun SPARC Enterprise 75240

<

Transferting data from webcast-west.sun.cam ..

23

Source: http://www.sun.com/servers/coolthreads/t5140/qgallery/index.xml?p=1&s=2
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Intro Home Wiew 4 Bengfits

Front

Internals

Sun SPARC Enterprise T5140
Sun SPARC Enterprise T5240
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Intra Harme View 4 Benefits

View > Rear

Sun SPARC Enterprise TS140 Server

CLICK AN 100N TO WEL) TNEDIA..

4

Source: http://www.sun.com/servers/coolthreads/t5140/gallery/index.xml?p=1&s=2
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Intro Home

WView . Bensfits i
View > Rear

Sun SPARC Enterprise T5140 Server

Intro Home View

4 Benefits P
View > Rear

00:0

< >1LOM Service Processor
Sun SPARC Enterprise T5140 Server

b

The ILOM service processor serial and 100100
ethemnat management ports (RG), provide
management access to the sarver once power is
plugged into the chassis.

Source: http://www.sun.com/servers/coolthreads/t5140/gallery/index.xml|?p=1&s=2
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